
 

 

 

 

 

RaceTCS is designed for motorsport use only. 

 

Incorrect installation of RaceTCS might result in damage to RaceTCS or other car components. 

 

RaceTCS holds no responsibility for damages caused by improper installation or use. 

 

Read the manual before attempting to install the device or ask a professional for help. 

 

 

 



RaceTCS V3 User Manual   Version 1.04 

 

 Page 2  

 

 

 

1. Requirements ................................................................................................................................... 3 

2. RaceTCS functions .......................................................................................................................... 3 

3. RaceTCS operating principle .......................................................................................................... 4 

4. RaceTCS logic ................................................................................................................................. 5 

5. RaceTCS package............................................................................................................................ 6 

6. PC application – RaceTCS Configurator ...................................................................................... 13 

7. Configuring RaceTCS ................................................................................................................... 19 

8. Configuring RaceTCS – advanced features .................................................................................. 25 

9. Firmware update ............................................................................................................................ 27 

10. FAQ ............................................................................................................................................... 28 

11. Car specific schematics ................................................................................................................. 31 

a. Nissan 350Z ............................................................................................................................... 31 

b. Nissan 300ZX ............................................................................................................................ 33 

c. Opel Speedster/VX220 turbo .................................................................................................... 34 

d. BMW E36 ................................................................................................................................. 35 

e. BMW E46 ................................................................................................................................. 37 

f. Mazda RX8 ............................................................................................................................... 43 

g. Mazda MX5 NC (pre-lift) ......................................................................................................... 44 

h. Mazda MX5 NC 2012+ ............................................................................................................. 44 

i. Ford Mustang GT 5th gen ......................................................................................................... 45 

12. Version history .............................................................................................................................. 46 



RaceTCS V3 User Manual   Version 1.04 

 

 Page 3  

 

 

 

1. Requirements 

 

RaceTCS works with petrol engines that meet following requirements: 

 Fuel cut mode 

o Sequential Fuel Injection (one injection once per 2 crank revs).  

Batch/bank injection is also supported (two injections per 2 crank revs). 

RaceTCS does not support fuel cut for Direct Injection engines 

o High impedance fuel injectors (10 ohms ore more)  

o The car has no misfire detection or has it disabled. If misfire detection is active and 

RaceTCS is connected, Check Engine Light can pop up and indicate damaged ignition 

coil. 

o Injectors are not PWM controlled  

 Spark cut mode 

o Active ignition coils (+5V signal) 

o The car has no misfire detection or has it disabled. If misfire detection is active and 

RaceTCS is connected, Check Engine Light can pop up and indicate damaged ignition 

coil. 

 

2. RaceTCS functions 

 

 Keeping wheel slip at Target Slip 

 Keeping RPM at specified threshold 
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3. RaceTCS operating principle 

 

RaceTCS operates on the principle of wheel speed difference between driven wheels and non-

driven wheels (reference). When the difference exceeds the threshold, RaceTCS takes action to 

limit this difference to level defined by the user. This is achieved by reducing torque output from 

the engine. 

When torque reduction is needed (RPM limiter or Wheel slip limiter), RaceTCS cuts the impulse to 

injector or ignition coil. It cuts the whole impulse, so no fuel is injected during that power stroke. 

In case of ignition cut, it can also retard the timing (defined by the user). This is achieved by 

extending the coil dwell time and triggering spark with a delay to original ECU signal.  

In case of fuel or ignition cut, there will be a false lean reading by oxygen sensor (lambda), because 

instead of exhaust fumes, clean air is being pumped to the exhaust. This has minimal effect on the 

mixture in the next power stroke.  

Fuel cut has no negative effect on Exhaust gas temperature and it should allow the cylinder to cool 

with incoming air. 

Ignition cut might cause Exhaust gas temperature to increase, due to fuel being burnt outside of 

engine cylinder. This can have negative effect on turbocharger or catalytic converter, so should be 

used with caution. 

Retarding ignition timing increases Exhaust gas temperature as well, so bear that in mind when 

using this feature. 



RaceTCS V3 User Manual   Version 1.04 

 

 Page 5  

 

 

4. RaceTCS logic 

 

RaceTCS logic can be divided into 2 functions: 

 

 RPM limiter – keeps RPM below specified limit 

o Clutch pedal down 

 Car stationary – Launch control RPM limit (if enabled via Enable LC) 

 Car moving – Flat shift RPM limit (if enabled via Enable FS) 

o Clutch pedal up 

 Car speed below Activation Speed – limit RPM to Start RPM 

 Wheel slip limiter – keeps wheel slip at specified limit 

o Car speed above Activation Speed  and RPM above Activation RPM  - torque 

reduction on slip severity 

 Slip <= Target Slip  - 0% cut 

 Slip >= Maximum Slip  - 100% cut (limited by Max slip fuel cut and Torque cut 

curve, whichever is smaller) 

 Slip between Target Slip and Maximum Slip – torque reduction depending on 

road conditions, trying to maintain slip close to Target Slip 

 

 
RaceTCS RPM/Wheel slip control 



RaceTCS V3 User Manual   Version 1.04 

 

 Page 6  

 

 

5. RaceTCS package 

Package includes: 

 RaceTCS device 

 Wiring harness 2m long, wheel speed sensor wiring 3m long 

 Preset selection potentiometer with label plate 

 LED and 100R resistors 

 

RaceTCS device with accessories 
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Installation schematics – general 

General schematic outlines all possible connections to RaceTCS. Below are partial diagrams for 

specific setups (Fuel cut mode, Spark cut mode, non ABS installation) 

 

RaceTCS schematics - general 

 

RaceTCS connection – Fuel cut mode 
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RaceTCS connection– Spark cut mode 

 

 

RaceTCS connection without ABS  
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RaceTCS connector pinout 

 RaceTCS connector pinout (early version) 
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 +12V (4/L-M) – power supply with ignition  

 GND – Power (1/L-M) – power ground for injectors. It is internally connected with regular 

GND (1-2/A-B), but this one is close to transistors and it is recommended to have 2 wires that 

support 5-10A current (1mm2). 2 GND PWR and 1 GND should be separate and they should 

join in a common grounding point with other electronics (engine block or engine head). 

 Led out (4J) 

o Indicates current RaceTCS setting. When user changes settings via potentiometer, diode 

blinks indicating current preset (1-6). When RaceTCS is completely off, the diode is 

constantly on. 12V LED should be connected to this output with negative end, while 

positive end should be connected to +12V 

When RaceTCS is active and wheel slip is detected, it indicates this condition by blinking. 

In case of a factory handbrake indication on the dashboard with a simple switch, it is 

possible to connect this output in parallel to this switch, to have RaceTCS indication on the 

dash.  

o Can be used to output digital signal (PWM) informing about requested slip fuel cut and 

selected preset. 1000us period indicates preset1, 950us - preset2, 900us - preset3, 850us – 

preset4, 800us – preset5, 750us – preset6, 700us - tcs off. PWM duty indicates slip fuel cut, 

0% PWM = 0% fuel cut,90% PWM = 100% fuel cut  

o Can be configured as digital output for display. It uses AIM protocol (UART 9600 bit/s, 5 

bytes per frame) 

 Clutch in (4H) –clutch switch input. This is mandatory if Flat Shift or Launch Control is 

used.  ClutchIn can use 4 input signals: 

o 0 – clutch press shorts to ground 

o 1 – clutch press disconnects ground (normally short to ground) 

o 2 – clutch press shorts to +12 

o 3 – clutch press disconnects +12 (normally short to +12) 

 FrontLeft (3G) – wheel sensor input for front left wheel  

 FrontRight (3H) – wheel sensor input for front right wheel  

 RearLeft (3J) – wheel sensor input for rear left wheel  

 RearRight (3K)- wheel sensor input for rear right wheel 

ABS signals – it is most convenient to pick up ABS signals near ABS pump main connector. 

Each sensor cable consists of 2 wires.  

VR sensors will have one wire short to ground when connected to ABS pump (and ignition is 

on), and one hot, so identifying the hot wire is easy when ignition is on. With VR (variable 

reluctance) sensor, hot wire will have sinusoidal signal and the other one will have contact to 

ground.  

In case of Hall sensor (found in modern cars manufactured after 2000), you need to find signal 

wire. Voltage should oscillate on the signal wire when you move the car a little. If voltage is 
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outside RaceTCS operating range (above 5V), you will have to install a series resistor on 

ground wire to the sensor and pick up the signal between the resistor and sensor. Please refer 

to schematics above. Hall sensor flows variable current, so voltage drop on that resistor is the 

pickup signal for RaceTCS. They usually work with 1V ABS ref vol. 

Some Hall sensors have 3 wires, +12/Ground/Signal. 3rd wire is signal pickup. These sensors 

work best with 2.5V ABS ref. vol., because they switch between 0 and supply voltage. 

 GND – ground (1-2/A-B) – can be used as ground for external sensors, potentiometer etc.  

 Output 1-8 (1/C-K) 

o Fuel cut mode - injector output (ground). Connect it to injectors, as RaceTCS will operate 

the injectors instead of original ECU.  

o Spark cut mode – ignition coil output (+5V controlled active coils). Connect it to active 

ignition coils, as RaceTCS will operate coils instead of original ECU.  

 Pot in (3A) – potentiometer input (10kOhm). Potentiometer with pins up, left pin +5V out 

from RaceTCS (4/A-B), middle pin to Pot In (3A), right pin to GND (1-2/A-B). 

 

Potentiometer has 11 positions, each position selects different preset as visible on label plate 

When potentiometer is disconnected, it selects preset1 as default (safe setting).  

Each preset is indicated by LED blinks, number of blinks represents a preset. Preset 1 - 1 

blink, preset 6 - 6 blinks. When RaceTCS is inactive, LED will be on all the time. 
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 Input 1-8 (2/C-K) 

o Fuel cut mode - injector input (ground controlled injectors). ECU output for injectors 

should be connected to Input 

o Spark cut mode – ignition coil input (+5V controlled active coils). ECU output for ignition 

coils should be connected to Input 

 0-5V out (4K) - it is used to output 0-5V signal indicating requested torque reduction. Can be 

used to log data in external devices or control torque with external devices 

 +5V out (4/A-B) - +5V supply from RaceTCS to external sensors, potentiometer 
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6. PC application – RaceTCS Configurator 

RaceTCS configurator is a portable application. It means you do not install it on your PC, just 

download the zip file and unpack (extract) the content to a folder. You should see following folder 

content. Run RaceTCSConfiguratorV3.exe to start the application. 

 
 

 

PC app requires .Net framework 3.5 (Windows 7 and higher have it preinstalled) 
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 How to use  RaceTCS Configurator 

o Read from device - reads configuration from connected device 

o Save to device - saves config to device and restarts RaceTCS. It is recommended to do this 

while engine is off 

o File->Save/Load settings - allow to save/load settings on your computer 

o Each setting in PC app has a tooltip – hover mouse over to see the explanation 

 

 

o PC app is used to configure RaceTCS. The most important settings are wheel size and ABS 

tooth count. To verify these settings are correct, open Logging tab and run a log while the 

car is moving straight without any wheel spin. All wheel speed should be identical and 

similar/equal to speedometer/GPS. 

o Auto-load default settings on start feature – when RaceTCS configurator is opened, it looks 

for default.xml file in Settings folder. If it cannot find that file, it loads hardcoded settings. 

If you store your RaceTCS settings as default.xml file, it will be always loaded when 

application starts. 
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 Application sections 

1. Activation 

 Activation RPM – below that RPM slip control is inactive 

 Activ. Speed – below that speed Start RPM limit is active, above that speed slip 

control is active 

 Start RPM – RPM limit applied before reaching Activ. Speed 

 Start RPM when moving – Start RPM limit active when at least one wheel speed is 

above 0  

 Deactiv. Speed – above that speed slip control is inactive 

2. Slip control 

 Target slip – slip above which RaceTCS will activate torque reduction 

 Minimum speed diff – speed added to reference wheels before calculating slip. Below 

this settings there are 4 values for effective % slip target at 50/100/150/200 km/h 

 Max slip torque cut – maximum torque cut used for slip control 

 Max RPM torque cut – maximum torque cut used for RPM control 

 Kp – P component multiplier 

 Ki – I component multiplier 

 Kd – D component multiplier 

 PID period – how often I and D components are recalculated 

 I limit – maximum value I component can reach 

3. Clutch 

 Enable LC – if checked, Launch Control feature is active above RPM 

 Enable FS – if checked, Flat Shift feature is active above RPM 

 Clutch delay – how long slip control is inactive after clutch is engaged 

4. Other 

 Ignore inj – ignores injector pulses shorter than set value for RPM calculation 

 Welded diff margin – cuts torque if driven wheel difference (left/right) exceeds set 

value 

 Use slower driven wheel – if checked, uses slower driven wheel for slip calculation 

 Use slower reference wheel – if checked, uses slower reference wheel for slip 

calculation 
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5. Global settings – settings applied globally, regardless of selected preset 

 RPM divider – divides injection pulses for RPM calculation by this value 

 Invert LED output – inverts output logic for led indication. Default used active 

ground. 

 Clutch config – selects different clutch configurations  

 AntiTheftEnabled – if enabled, clutch has to be pressed 3 times in 3 seconds after 

ignition is active, otherwise output to injectors/coils is disabled 

 Is FWD – enable for FWD cars, disable for RWD cars 

 LC/FS always on - FlatShift and LaunchControl will be always on, even with 

RaceTCS pot in off position 

 ABS ref vol. – Reference voltage for ABS sensors. Most VR sensors use 0V as 

reference, some use 2.5V , Hall effect sensors will use ~1V, depending on application. 

 Wheel input mapping – allows to remap wheel inputs used for wheel speed calculation 

 Staged inj. - used for staged injection setup. Pair settings requires injector pairs to be 

connected to 1&5, 2&6, 3&7, 4&8 inputs and outputs. Group settings require injectors 

to be connected to 1&3&5&7 and 2&4&6&8.  

Injector that is opened 1st should be always connected to lower port number. If you 

have injector pairs, you connect one pair to 1&5 and the faster opening injector should 

be connected to input/output 1. Another pair should be connected to 2&6, with faster 

opening injector connected to input/output 2. 

 Injectors/Coils - Select if injector signals are controlled (active ground) or active 

ignition coils (active +5V). 

Coils inverted is when stock ECU used passive coils (ground active) and engine is 

equipped with active coils (active +5V) 

 ABS signal diagnostics - If diagnostics is on, it indicates missing ABS signal in 

RaceTCS via LED. If at least one reference wheel exceeds activation speed and any 

other wheel speed is 0, the LED is on 

 LED function - Led function: 

o LED - work as regular LED 

o PWM Out - output pwm signal on LED, 1000us period indicates preset1, 

950us - preset2, 900us - preset3, 700us - tcs off. PWM duty indicates slip fuel 

cut, 0% pwm = 0% fuel cut,90% pwm = 100% fuel cut 

o Digital display - output digital transmission for display 

 Low wheel tooth count – use this option, if you have wheel tooth count < 10. Changes 

timer precision to cover low speed range 

 Use Inj8 as Fuel Cut Indicator - use this option to use Inj8 output as full fuel cut 

indication.  
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o When during RPMlimit, MaxRpmFuelCut is reached or 

o When during SlipControl, MaxSlipFuelCut is reached, Inj8 output will be 

triggered. It can be used as a hard cut for non standard installations 

 Maximum ign. retard - Defines maximum ignition retard when in Coils mode. Before 

spark cut is applied, it retards ignition for faster and smoother torque reduction. 

Ignition retard is achieved by longer coil dwell pulse (delaying spark signal).  

 Torque cut curve - The curve defines 8 values, which are used by PID output to select 

torque cut 
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 Logging 

After logging is started (play icon) current readings will be displayed live. All logs are 

automatically saved to Log directory in the main app directory. Each new log creates file name 

with date and time. Log can be opened in RaceTCS Configurator for later analysis or sent to 

support. Log channels can be show/hidden by clicking on channel text.  
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7. Configuring RaceTCS 

To correctly configure your RaceTCS for the 1st time, please follow these steps: 

 Run PC application 

 Load settings for your car (if available) from File-> Load settings menu. If not available, start 

with default settings (loaded when PC application starts) 

   

 

 Configure wheel sizes. Copy wheels to all button copies wheel settings from Front left wheel 

to all 4 wheels.  

 Current wheels to all button copies wheel settings from current preset to all presets 

 Current to all except slip button copies current preset settings to all presets, except slip 

settings (Target Slip, Maximum Slip, Minimum speed difference) 

 Verify that each preset has correct wheel setting by selecting “Current preset” from 1 to 6. 

 Save the settings from File->Save settings for future use.  
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 When you connect your PC to RaceTCS device and turn ignition on for the 1st time, press 

Save to device button and you should see a confirmation message.  

 

 

 

 If your RaceTCS is not powered or not correctly connected, you can see error message when 

trying to save  

 

 

This can also indicate that USB drivers are not installed on your system. You can try installing 

newest drivers for FTDI VCP https://www.ftdichip.com/Drivers/VCP.htm 

 

 If you correctly save settings to your RaceTCS device, you can verify that all is set up 

correctly. Go to logging tab and press start log button.  

 

 

 

https://www.ftdichip.com/Drivers/VCP.htm
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You should see a log being displayed. Log file is automatically saved to Logs folder. 

 

 

 

 Now you can start the engine and drive around to verify, that wheel speeds are identical (or 

very close to each other) while driving at constant speed in a straight line. It should look like 

in the picture below: 
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 If you have difference between wheels, verify that tire size settings match your tires on the car 

and ABS tooth count is correct. If you do not know the correct ABS tooth count, you can just 

change the settings, save to device and start the log again to verify. Remember to copy wheel 

settings to all presets after each change by pressing Current wheels to all button and 

saving to device after change.  

Picture below shows an incorrect setting - rear wheel speed is higher than front 

 

 

 One possible mistake is incorrect ABS reference voltage setting. With VR sensor the result 

will be no speed detection until speed is high, for Hall sensor signal might be unreliable, like 

in picture below 
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 If everything with wheel size is correct, you can try accelerating so that you lose traction. It 

should be visible in a log. Wheel speed between driven wheels and reference wheels should be 

different (blue lines), slip should be indicated by pink line and torque reduction by green line 

 

 Setting up Start RPM and Launch Control requires trial and error. Best approach is to 

accelerate in 1st gear from 1000 RPM and see, when engine has enough power to cause 

wheels to slip. In example below this happens around 3500, so we chose Launch Control to be 

3700 and Start RPM 3300 (when clutch is engaged and car is starting to move).  
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 We used 3700 RPM for Launch Control to have around 0.5 bar of boost. After clutch pedal is 

released, we use Start RPM of 3300. At 3300 RPM car has around 28km/h. We set 24km/h as 

activation speed (speed at which Start RPM limit deactivates and wheel slip control activates). 

Launch Control RPM should be around the RPM, where engine has enough torque to spin the 

wheels (picture above). Start RPM should be as low as possible, where engine can maintain 

wheel slip.  

 

 If you set Launch Control RPM to a too low value, then the start will be slow, because engine 

has too little torque to maintain wheel slip. Also make sure that Start RPM is at least 5% 

above RPM that you have at Activation Speed. Otherwise switch from RPM Control to Slip 

Control will not be smooth or car might stop accelerating before reaching Activation Speed.  
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8. Configuring RaceTCS – advanced features 

 

RaceTCS comes with default settings that work well on most of the cars. There are also settings for 

few cars, which we tested ourselves and know these settings work. Depending on your car setup, 

power adders, gearbox etc. you might need to make few changes. If you need help, please contact 

our support at www.racetcs.com#support. 

 

 

 

The settings that affect RaceTCS operation the most are: 

 Target Slip – this is the slip that RaceTCS is trying to achieve if actual slip exceeds target slip 

 Torque cut curve – the curve which defines how steep torque reduction curve is in function 

of PID controller value.  

 Kp,Ki,Kd – this is the multiplier for each component 

 PID period – how often each component of PID is recalculated 

 I limit – how big I component can grow over time.  

How much torque is cut depends on the way PID controller is set up.  

 

P is proportional, it depends on how far current slip exceeds target slip. Value of 2 will have a full 

cut when current slip exceeds target slip by 50%  

 

http://www.racetcs.com/#support
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I is integral, it increases when current slip is above Target Slip and decreases if below. This allows 

PID controller to adjust the output to current conditions.  

 

D is deriviative, it is positive when rate of slip change is positive, and negative if rate of slip 

change is negative. It is most effective when there is big change of slip value in short period of 

time. One wheel driving over ice patch or water is example. D is active 5% below Target Slip. 

This is to compensate for the delay between torque reduction and wheel speed reduction. 

 

If you have too instant and too hard reaction to slip, you need to identify which PID component is 

causing this issue and try reducing it’s multuplier.  

If this is not enough, you can try changing Torque cut curve to a milder 0,5,10,20,30,40,70,95 

from the default 5,10,20,30,40,60,80,95. 

 

Tuning PID controllers is not easy task and requires trial and error. Each component value can be 

seen in the log, so this should help understand when each component is having effect on torque cut.  

  

Please contact our support if you need help with setting up RaceTCS for your car. 
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9. Firmware update 

 

To update firmware, select File menu, Firmware Update and select firmware file to be updated. 

Green progress bar will indicate when process is finished. RaceTCS should automatically restart, 

so do not update firmware when engine is running  

 

When application is launched and newer version is found on webpage, a popup will show.  

When you read settings from RaceTCS and newer firmware is available for update, a popup will 

show. Make sure to use newest firmware available, as new features are added. Change log is 

available in Help->About menu. 
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10. FAQ 

 How to connect 2 wire hall sensor to RaceTCS without ABS?  

o Refer to schematics in section 3. Set ABS ref voltage to 1.0V and test. Find the optimal 

voltage (no signal noise) by trial and error, or measure with a voltmeter voltage range 

(minimum – maximum) and set ABS ref voltage in the middle 

 How to connect VR sensor to RaceTCS without ABS? 

o Refer to schematics in section 3. Set ABS ref voltage to 0.0V 

 How to connect 3 wire hall sensor to RaceTCS without ABS? 

o Refer to schematics below. For 3 wire hall sensor ABS ref voltage should be set to 2.5V 

 Everything seems to be set up correctly, but RaceTCS is not controlling wheel spin 

o Make sure clutch signal is low (0) when clutch is engaged (clutch pedal up). When you 

press clutch pedal with your foot, it should indicate high (1) in the log. Refer to log 

screenshots in section 6 

 How to connect 2 wire hall sensor to RaceTCS with ABS? 

o You need to solder a resistor in series on ground wire and pickup signal after the resistor. 

This is very common in cars manufactured 2010+. Please refer to schematic in section 3 

 How to connect VR sensor to RaceTCS with ABS? 

o Find which wire is signal and connect RaceTCS wheel input from there. Use shielded wire 

with shield attached to GND on just one end. Some sensors have a voltage offset, if ABS 

ref. voltage 0V does not work, try different value until you see a signal. 
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 I cannot connect my laptop with RaceTCS 

o RaceTCS needs to be powered with +12V to be able to connect. Please check that when 

you connect RaceTCS with USB cable, device is visible in Windows “Device Manager” as 

USB serial converter  

 

 

If this does not help, please try installing drivers from FTDI website : 

https://ftdichip.com/drivers/d2xx-drivers/ 

 

 How to connect and configure RaceTCS when I have only one gearbox output shaft speed 

sensor? 

o Connect wheel speed sensor to one input (RL in out example) and map both rear wheel 

speeds to RL input. Multiply the tooth count from the trigger in gearbox by the diff ratio. If 

you have 40 tooth and 3.42 diff, this equals to 137. 

 

https://ftdichip.com/drivers/d2xx-drivers/
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 I connected RaceTCS as in schematic, device works, USB connection works, but my car does 

not start. What can be wrong? 

o Make sure +12V is uninterrupted source (preferably from stock ECU). Some circuits get 

interrupted during cranking. If RaceTCS is connected to such a circuit, the engine won’t 

start. You can verify it easily, put RaceTCS pot in OFF position, LED should be constantly 

on. While your crank the engine, LED should stay on all the time. If it goes off, it means 

power supply is interrupted. 

 What wire thickness should I use? 

o RaceTCS is delivered with a wiring harness. If you still need to make your own harness, 

use 0.5mm2 (20AWG) for all the wires except GND power connection. GND power should 

use 1mm2 (17AWG). Make sure to have 3 separate GND wires connecting to a common 

grounding point, 2 Power GND and one GND. This ensures voltage drop does not affect 

signal input to RaceTCS. 
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11. Car specific schematics  

Schematics below are supposed to help with installation in common cars. It does not mean that cars 

not listed here are not supported. The list will grow as we get more customers asking for support 

with installation 

a. Nissan 350Z 

ECU diagrams  
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VDS/TCS/ABS Diagrams 
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b. Nissan 300ZX 
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c. Opel Speedster/VX220 turbo 

 

There is a DYI guide for VX220 made by VX220.org.uk members.  

https://racetcs.com/files/DIY%20Guide%20VX220.pdf 

 

https://racetcs.com/files/DIY%20Guide%20VX220.pdf
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d. BMW E36 

 

FL signal – 37, RL signal – 34, FR signal – 15, RR signal - 35 

 

FL signal – 1, RL signal – 6, FR signal – 19, RR signal – 22 
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FL signal – 48, RL signal – 46, FR signal – 47, RR signal – 45 
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e. BMW E46 

BMW E46 uses hall sensors with built in resistor in ABS pump on +12 line. RaceTCS requires 

signal on ground wire, so a series resistor (~ 100ohm) is needed to be added. 

 

 

Hall sensor connection with abs 

 

There are 4 different ASC/DSC pumps with different pinouts, but all share the same wiring 

colors. 

FR – BR GE (solder resistor on BR) 

FL – BR BR/RT (solder resistor on BR) 

RR – GE/BR GE/SW ( solder resistor on GE/BR) 

RL – BR BL (solder resistor on BR) 

 

braun BR = brown 

blau BL = blue 

rot RT = red 

gelb GE = yellow 

grau GR = gray 

schwarz SW = black 

weiss (weiß ) WS = white 

grun GN = green 

orange OR = orange 

rosa RS = pink 

violett VI = violet 
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FR ground – 19, FL ground – 1 , RR ground – 23, RL ground  - 5 



RaceTCS V3 User Manual   Version 1.04 

 

 Page 39  

 

 

 

 

 



RaceTCS V3 User Manual   Version 1.04 

 

 Page 40  

 

 

 

 

 

 



RaceTCS V3 User Manual   Version 1.04 

 

 Page 41  

 

 

 



RaceTCS V3 User Manual   Version 1.04 

 

 Page 42  

 

 

 



RaceTCS V3 User Manual   Version 1.04 

 

 Page 43  

 

 

f. Mazda RX8 

Mazda RX8 pre R3 used VR sensors on all wheels.  

Wire colors and pin position in ABS/DSC connector is shown on a diagram below: 
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g. Mazda MX5 NC (pre-lift) 

MX5 MK3 (according to user reports) uses Hall sensors. Signals alternate between 0.5 and 

1V, so there is no need for a resistor. ABS Ref voltage should be set to 0.76V. 

h. Mazda MX5 NC 2012+  

MX5 MK3.5 and up use Hall effect sensors (the same is with RX8 R3 version). You need to 

solder 100ohm resistor on ground wire and connect signal pickup between Resistor and wheel 

sensor 
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i. Ford Mustang GT 5th gen 
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12. Version history 

Version Date Changes 

1.0 2022-11-30 Initial version 

1.01 2023-01-09 Formatting corrections 

1.02 2023-03-10 Added advanced configuration section 

1.03 2023-04-09 Updated PC app description 

1.04 2023-06-25 Updated schematics, wiring harness 

color coding, PC application 

description 

 


